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Disclaimer
Users of MetaEdit must accept this disclaimer of warranty. MetaEdit is supplied as is.  The 
author  disclaims  all  warranties,  expressed  or  implied,  including,  without  limitation,  the 
warranties of merchantability and of fitness for any purpose. The author assumes no liability 
for damages, direct or consequential, which may result from the use of MetaEdit."

MetaEdit is a "shareware program" and is provided at no charge to the user for evaluation. 
Feel free to share it with your friends, but please do not give it away altered or as part of  
another system.  The essence of "user-supported" software is to provide personal computer 
users with quality software without high prices, and yet to provide incentive for programmers 
to continue to develop new products.  If you find this program useful and find that you are 
using MetaEdit and continue to use MetaEdit after a 30 day trial period, you must make a 
registration payment of 75$ (US) to MetaCase Consulting.   The 75$ registration fee will 



license one copy for use on any one computer at any one time.  You must treat this software  
just like a book. An example is that this software may be used by any number of people and 
may be freely moved from one computer location to another, as long as there is no possibility 
of it being used at one location while it's being used at another. Just like a book cannot be read 
by two different persons at the same time.

Commercial users of MetaEdit must register and pay for their copies of MetaEdit within 30 
days of first use or their license is withdrawn.  Site-License arrangements may be made by  
contacting MetaCase Consulting. The file "register.wri" contains the order form.

Anyone  distributing  MetaEdit  for  any  kind  of  remuneration  must  first  contact  MetaCase 
Consulting at the address below for authorization. This authorization will be automatically 
granted to distributors recognized by the (ASP) as adhering to its guidelines for shareware 
distributors,  and  such  distributors  may  begin  offering  MetaEdit  immediately  (However 
MetaCase Consulting must still be advised so that the distributor can be kept up-to-date with 
the latest version of MetaEdit.).

You are encouraged to pass a copy of MetaEdit along to your friends for evaluation.  Please 
encourage them to register their copy if they find that they can use it.  All registered users will  
receive a copy of the latest version of the MetaEdit system, printed manual and manuals for  
the methods that are in this package.

Preface
Thank  you  for  purchasing  MetaEditÔ,  the  simple  but  powerful  graphical  CASE  tool! 
MetaCase Consulting sincerely hopes that this tool will help you in your work.

MetaEdit comes in three versions:

MetaEditÔ Standard
MetaEditÔ Professional
MetaEditÔ Professional with Method Workbench

The  standard version  of  MetaEdit  is  fully  functional  as  a  modelling  tool  but  offers  no 
customisability. It  cannot use models created with other versions of MetaEdit.  This is the 
documentation  of  the  Standard  version,  modified  for  shareware  purposes.  To  receive  the 
standard version with additional methods, please fill in the ordering form.

MetaEdit  Professional can  be  ordered  with  as  many  methods  available  in  MetaCase 
Consulting's  method  base  as  you  want.  If  this  is  not  enough,  MetaCase  Consulting  will 
provide  — for a separate fee — your very own method support for this version. MetaEdit 
Professional can use models created with any version of MetaEdit, including the user-defined 
methods made using the Method Workbench.

MetaEdit Professional with Method Workbench offers you full customisability. In addition 



to  the  basic  functionality  of  the  Professional  version,  you  can  define  and  use  your  own 
methods  and  reports  within  the  limits  of  the  general  MetaEdit  architecture.  MetaEdit 
Consulting will be happy to teach you how to do this.

This manual describes the features of MetaEdit Standard. It has four chapters: the first one 
introduces you to CASE and CASE tools and lists the differences between MetaEdit and most 
existing CASE tools. The second chapter lists the requirements for a successful installation of 
MetaEdit and guides you through the installation process. The third chapter explains how you 
create  and manipulate  models  in  MetaEdit.  The fourth chapter  is  a  brief  reference of  all  
standard menus of MetaEdit.

1.  MetaEdit  -  The  CASE  tool  with  a 
difference

Customisability

MetaEdit  is  a  CASE shell.  That  is,  it  is  a  CASE tool  that  can  be  extensively  modified 
(customised) to fit with different development methods, their graphical representations, and 
desired reports. These features are fully functional in the Method Workbench of MetaEdit. 
Since  we  at  MetaCase  Consulting  believe  that  the  average  user  is  not  interested  in 
continuously making changes, we offer the alternative of purchasing an already customised 
Professional  version to  suit  the  user's  specific  needs.  The Standard version is  even more 
straightforward and is intended for those users who are confident with using a few standard 
methods that are delivered with the tool.

MetaEdit professional can be customised in the following ways:
Available methods 
Graphical representations 
Reports 
Appearance

Most  common  information  system development  methods can  be  supported  by  MetaEdit 
Professional. With MetaEdit Professional with Method Workbench, you can even make your 
own methods and use them instead of or in addition to predefined ones. There are few other  
CASE tools that can do this, and none does it as easily as MetaEdit.

Report  customisation  or  use  of  user-defined  reports  is  also  possible  with  MetaEdit 
Professional with Method Workbench. You can choose which parts of your design data you 
want to have written out and in which format, save the report definition, and produce reports 
according to this format from your various design models.

Method independence



Since MetaEdit is a CASE shell  we can make use of various methods in it  (Professional 
version only). Those features of MetaEdit that are not directly dependent on a specific method 
will remain the same throughout. Thus MetaEdit can replace several method-specific CASE 
tools and ease the learning curve since you need not learn the usage of several tools from 
different vendors.

Overview of MetaEdit's features

Easy  usage: the  user-friendly  WindowsÔ  graphical  interface  eases  your  learning  curve, 
especially if you already use other Windows-based programs.

Easy data transfer: in the Windows environment you can cut pictures or text from MetaEdit 
and easily paste it into other programs such as a word processor or graphics package.

Easy customisation: the Professional  versions essentially let  you use your own in-house 
methods along with pre-defined common methods. With the Method Workbench you can 
easily design your own methods using a readily understandable graphical notation.

Automatic consistency checking: models that violate the method in use are impossible to 
make.

Easy viewing: selected parts of the model can be hidden to highlight relevant aspects of your 
design data. Comprehensive zooming and scrolling facilities.

Moderate requirements: if your machine runs Windows properly, it will also run MetaEdit.

Supported methods

Due to the powerful customisation features of MetaEdit, it can support numerous methods.  
This unlicensed version of MetaEdit Standard has support for the following methods:

- Structured Systems Analysis, SSA (Gane-Sarson)
- Entity Relationship Diagrams, ERA 
- Class Diagrams (Booch)

But by purchasing the registered version of the MetaEdit Standard you can get more methods 
of your choice. See the "register.wri" file for details.

2. Installation

Contents of MetaEdit package



The file contents.lst contains a list of files in the package. Contact the source you received the 
files from or MetaCase Consulting if it does not match with what you have.

Hardware requirements

MetaEdit will run on a PC with at least a fast 286 processor and 3 Mb main memory, an EGA 
graphics adapter and display (VGA or better recommended), a mouse or some other pointing 
device and 2 Mb free mass storage for the software. Remember, however, to allocate some 
disk space for the models you create as well.

If  you  must use  MetaEdit  on  a  machine  with  only  2  Mb  memory,  contact  MetaCase 
Consulting  for  a  "light"  version  of  MetaEdit.  We  strongly  recommend  upgrading  your 
hardware  instead,  if  at  all  possible,  since  performance  will  suffer  dramatically  and  large 
models may no longer be usable. No version of MetaEdit can be run with less than 2 Mb main 
memory.

Software requirements

MetaEdit requires MicrosoftÒ WindowsÔ version 3.0 or later in Standard or 386 Enhanced 
mode and working drivers for your mouse, display adapter and printer (optional). Please see 
your Windows manual for installing and configuring these, and the basic use of Windows. 
This manual assumes throughout that you are familiar with working in Windows and with 
basic Windows terms and operations such as "clicking" and "dragging".

Limitations

During the run time, MetaEdit stores all the design data (including all pictures) in the current  
model  in  a  special  memory  location  called  dynamic  memory.  This  makes  the  memory 
management very efficient: the data retrieval and store are fast. However, this causes also 
some limitations because the size of the dynamic memory is fixed. The theoretical maximum 
size of a model is the size of the dynamic memory. In practice the maximum size is slightly 
smaller because the user interface also uses some dynamic memory.

The default size of the dynamic memory is optimised to 512 kb. It is no real limitation if  the 
models  do  not  contain  long texts  in  text  fields.  If  you need larger  models,  a  version  of  
MetaEdit with dynamic memory up to 1Mb can be ordered from MetaCase Consulting. The 
amount of free dynamic memory can be seen by selecting Help | About MetaEdit... from the 
Main Window.

The other limitation of MetaEdit is the number of objects. When allocating new objects and 
relationships, MetaEdit uses up a pointer from the object pointer reserve. Each object and 
relationship also consumes some pointers depending on the properties it has. Object pointer 



reserve has room for about 20000 pointers. From Help | About MetaEdit... you can find the 
number of items in the current model. Items include objects, relationships, their properties,  
pictures  and  spatial  information.  Because  each  object  and  relationship  consumes  many 
pointers, the maximum size of a model is less than 20000 items. In practice, the maximum 
usable size of a model is about 5000 items. That should be enough for most purposes.

You should also notice that an open picture consumes more pointers than a closed one. So if 
you have a big model with several pictures, do not keep all the pictures open or iconised. 
Instead, close the ones that you do not need - the object pointers are then freed.

Instructions for installation 

Installing MetaEdit is very easy. In the following, we describe how to do this using Windows 
3.1 File Manager. First, create a directory for the software and the method definition (.MOF) 
files using Windows File Manager or a similar tool, or the DOS md command. For example, 
the directory could be named C:\WINDOWS\METAEDIT. Then copy all the files that come 
on  the  distribution  disk  to  this  directory.  At  least  the  following  files  should  be  in  this 
directory:

METAEDIT.EXE
METAEDIT.IMA
BOOCH_CL.MOF
ERA.MOF
SSA.MOF

Start Windows, if you did the previous tasks in DOS. Create a group for MetaEdit using 
Windows Program Manager  (click  File,  New,  Program Group).  As  the  description,  enter 
MetaEdit and as group name metaedit.grp. Then  choose the new group and add the MetaEdit 
program itself (click File, New, Program item.) For description, enter MetaEdit (or whatever 
you  want  to  call  the  program).  As  the  command  line,  give  the  path  of  the  MetaEdit 
executable, e.g. c:\windows\metaedit\metaedit.exe (you can also browse for the executable). 
Choose  the  MetaEdit  icon  you  like  by  clicking  the  change  icon  button.  As  the  working 
directory, enter the directory you just created and into which you copied the files, e.g. c:
\windows\metaedit. Assign a shortcut key if you wish, and click OK. The MetaEdit icon will 
now appear in the newly-created MetaEdit group.

If you are not using Program Manager, see the manual of your shell program on how to install 
new software.

Testing your installation

After you have completed the installation, double-click on the MetaEdit icon. The MetaEdit 
Main Window should appear with the MetaEdit logo. Click the logo once to get rid of it. You 
should now be through the installation and ready to start working with MetaEdit.



If something goes wrong, first check that the path and working directory are defined correctly 
(in Program manager select File, Properties). Change these if necessary and retry. Check also 
that all the files on the installation diskette have been copied to the directory (see above for 
the minimal list). Check that your Windows installation is configured to make full use of the 
memory installed on your machine, and that Windows is running in either Standard or 386 
Enhanced mode. If you have other Windows applications loaded, try closing down a few of 
them and restarting MetaEdit.

3. Using MetaEdit

In this chapter, we show how various tasks are done using MetaEdit. These tasks include 
creating new pictures, manipulating pictures, printing, and transferring pictures created using 
MetaEdit to other programs. Most importantly, we show how MetaEdit can be used to support 
various design and modelling tasks. 

We use data  flow diagrams (DFDs) from Structured Systems Analysis  (Gane and Sarson 
1979) as the example method. You should do these things with MetaEdit to get an idea of  
tasks.

Creating new pictures

By double-clicking on the MetaEdit icon in your Windows Program Manager the MetaEdit  
Main Window appears.  The Main Window provides  all  the  tools  used to  manipulate  the 
pictures.

To create new pictures position the cursor over and click once on the File menu, and select 
New Model. This opens a dialog which allows you to select any method contained in your 
version of MetaEdit.

The Select Method dialog contains two scrollable lists: the one on the left contains  all the  
method definition files while the one on the right shows your directory structure. All the 
method definition files have the ".mof" extension. To select a method position the cursor on 
one of files and double-click the file name, or enter the file name and select  OK. We have 
selected the Data Flow diagrams from Structured Systems Analysis (Gane and Sarson 1979). 
The Select Method dialog also includes a "Cancel" option to return to the Main Window.

After a method has been selected, the Main Window reappears with the picture list containing 
the text "[Structured Systems Analysis]" which shows the name of the selected method. After 
a method is selected the "New" button is highlighted to indicate that you can now create new 
pictures. 

To create a new picture click the New push button. Positioning the cursor on the button also 



has an effect on the help bar at the bottom of the Main Window. The help bar contains a short  
note to explain the capabilities of each function you position the cursor on. Positioning the 
cursor on the button "New" causes the help bar to show the text "Create a new picture".

The selection "New" opens a dialog which allows you to enter a name for the picture. We 
have given the name "Order system" for the picture. The name must be unique so that it can 
be differentiated from other pictures. To ensure this, MetaEdit prevents you from entering 
names which conflict. 

After you have entered a name for the picture, click the  OK button. If you do not want to 
create the picture after all, select Cancel instead. After you have accepted the picture name, a 
Draw Window opens, allowing you to draw pictures according to the selected method. In the 
next section we clarify how the Draw Window supports your design tasks. 

Drawing pictures

All the drawing tasks included in a selected method are done in MetaEdit's Draw Window. 
The title bar of the Draw Window contains the name of the picture and the name of the  
selected method. The drawing tasks supported by the Draw Window are:
- adding objects
- adding relationships
- updating objects and relationships
- deleting objects and relationships
In the following subsections we explain in detail each function mentioned above.

Adding objects

All the object types included in the selected method are collected in the Model menu. Thus, 
the content of the menu is dependent on the selected method. Look at "Draw"-menu. As you 
can  see,  the  Model  menu  includes  the  following  object  types:  "External","Process"  and 
"Store". The mark  on the left side of "External" denotes that it has been selected. If you want 
to draw objects of another type just click once on that object type's name. 

To draw a process select Model | Process. This function allows you to draw as the next step a 
process. Also the cursor type change illustrates that you are now in object drawing mode. To 
add  a  process,  position  the  cursor  anywhere  inside  the  Draw  Window  and  click.  This 
operation opens a dialog allowing you to enter a number and a name for the process. You can 
also add some extended information about the process in the Description field.

The first property in the dialog is also an identifier for the process, and thus it must be unique. 
However, if there already exists another process that has '1' as its identifier, the "Rename" 
push button in  the dialog changes to  a  "Duplicate"  button allowing you to enter  another  
process with the same name and properties.

After entering the properties of the process, select  OK  in the dialog. The process is then 



inserted into the selected place in the Draw Window. If you are not satisfied with the position 
of the object, you can move the object in the drawing area. To do this click the object once.  
Four small black boxes appear showing that it is now selected. 

To move the object, simply drag it to the place where you want it to be. A dashed line box 
shows the place where the object is moved to.

To create objects of other types available in the selected method just select  Model and the 
type of the object you need to create. If you want to draw another "process" you can add it 
straight into the drawing area, but for other objects, like "External" or "Store", you need to 
select them first from the Model menu. In other words, the most recently added object's type 
stays as the default until you select a new one from the Model menu.

Adding relationships

After you have created some objects, you may want to show how all the objects drawn are 
related to each other. To do that select Model | Change mode. By doing this you can change 
the operation mode from adding objects to adding relationships and vice versa. The other way 
to change the mode is to push the right mouse button (This manual assumes you are using 
your mouse right-handedly. If you have inverted the mouse buttons for left-handed use, just 
mentally reverse left and right in the descriptions henceforth). The selected operation mode is 
also reflected by the shape of the cursor. 

MetaEdit offers two ways to choose the relationships. The easier one, which we recommend 
is  to  select  Model  |  Relationships  |  Automatic which  lets  MetaEdit  select  the  correct 
relationship type. In other words, based on the chosen method and selected objects, MetaEdit 
can select the one possible type of relationship from the available ones. When it is possible to  
create more than one type of relationship between two objects, a dialog appers asking which 
one of  the possible relationships you want  to draw. This automatic function is  extremely 
useful because it reduces routine work and speeds the design and modelling work.

The alternative is to choose relationships manually, and this can be done by selecting first 
Model | Relationships and then from the menu the particular relationship which you want to 
draw. The manual relationship selection is useful in cases where you want to draw only one 
type of  relationship but  there  are  other  applicable  relationship types to  choose from. For 
example, in object-oriented methods we might be interested in only drawing class hierarchies 
between classes, and want to forget for a while about all the other possible relationship types, 
such as messages or instantiations.

To  draw  the  relationship  between  two  objects,  select  first  the  object  from  which  the 
relationship starts and then the object where the relationship ends. The question mark '?' in the 
cursor shows which one of the two objects should be selected:

- When the question mark is in the left side in the cursor, the tool expects that the starting  
point of the relationship will be selected next.
- When the question mark has moved to the right the tool expects that the ending point of the 



relationship will be selected.

If you want to cancel relationship drawing during the task just click the right mouse button 
and a dialog pops up to inform you that the creation has been cancelled.  After the two objects  
participating in the relationship have been selected, a dialog opens for entering the properties 
of the relationship. The dialog allows you to enter a number and a name for the flow. The help 
bar at the bottom of the dialog offers direct help for you when entering the properties. After 
you have entered the properties of the flow select OK. This operation inserts the relationship 
between the two selected objects.

The default for drawing a relationship between two objects is to draw one straight line. It is  
also possible, however, to move the place of the relationship by adding a break point to the 
line that represents the relationship. This can be do in two ways. The first one is done  as in 
the case of moving objects  by selecting the relationship (i.e click the small square in the 
middle of the relationship) by clicking the left mouse button and holding it down. Then move 
the cursor to the place through which you want to draw the relationship line.

If you are not satisfied with one break point in the relationship line, you can add an arbitrary  
number of them. To do this click the left mouse button at an empty place in the drawing area 
after you have chosen the first object in the relationship. This operation draws the relationship 
line from the first selected object to the cursor. Repeat clicking the left mouse button in the 
drawing area where you want the break points to appear, and finally click the object where the 
relationship ends.  As a result  of  connecting the second object,  the relationship properties 
dialog appears.

If  you  want  to  move  the  break  points  in  the  relationship  line,  just  move  parts  of  the 
relationship line by selecting and dragging the small  squares in the relationship line.  For 
reducing a relationship to a straight line, select the relationship by clicking it once and select  
Edit | Straighten Line (CTRL-S).

Updating objects and relationships

During design tasks you often need to update and change the pictures created with MetaEdit. 
To update the objects or relationships you have created previously, first select the one you 
need to update by positioning the cursor (in object mode) on it, and either double-click it or,  
after selecting the item by clicking it once, choose Edit | Show Properties (CTRL-P). In both 
cases the property dialog for the object or relationship pops up allowing you to update the  
properties.

The property dialog for objects differs from the relationship dialog in one way. That is the 
possibility of renaming the object by changing its unique name. This can be done by selecting  
Rename in the object property dialog.

Deleting objects and relationships



Deleting an item from the Draw Window can be done in two ways. First select the object or  
relationship (in the case of relationship click the small box in the middle of a relationship 
line). Then either press the keyboard delete key or select Edit | Delete from the menu.

The deletion operation does not ask for confirmation of the operation, and thus removes  the 
selected  object  or  relationship  straight  away.  N.B.  if  you  delete  an  object,  all  the 
relationships connected to that object are also removed!

Viewing objects and relationships

The View menu in the Draw Window offers a useful function to handle and present complex 
pictures.  In  other  words,  the Draw Window shows either  all  the  drawn objects  and their 
relationships, or allows you to filter the view. By filtering we mean a function that allows you 
to select only those object and relationship types from the picture that interest you, and hide  
the rest. 

To view objects or relationships select  View | Selected. This operation opens a dialog for 
selecting those object and relationship types you want to see in the Draw Window. The dialog  
contains all the same method-specific object types as the Model menu. To select object or 
relationship types, click them, which causes them become highlighted. The dialog contains 
also three options for showing relationships. These options are:

- Complete orphan relationships, which shows also those hidden objects that are involved in 
one of the selected relationship types.

-  Show all instances of selected types,  to show only the selected object and relationship 
types.

- Hide orphan relationships, to hide the relationships that are incomplete (one or both of the 
objects at the end of the relationship line are hidden).

In the case of data flow diagrams in Structured Systems Analysis, one useful way to view 
objects is to concentrate only on the processes and data stores and hide the external objects.  
To view all possible objects and relationships you can either mark both 'all' selections in the 
View dialog or select View | All.

Decomposing objects to pictures

Some  diagramming  methods  make  use  of  a  decomposing  feature  which  allows  you  to 
examine the modelled system at different levels of detail. Thus, as a result of decomposition a  
hierarchy of pictures is created. In MetaEdit this decomposition from objects to pictures is  
called  explosion.  Each exploded picture  can be also seen in  the picture  list  of  the Main 
Window.



To explode objects, select first the object by clicking it once. Then select Edit | Explode To 
Picture (or press CTRL - E). This operation opens a new Draw Window allowing you to 
specify the system in more detail.

Saving models

To save the models drawn in the Draw Window, select File | Save from the Main Window. If 
the model has not been saved already  (there is no path or file name in the title bar of the Main 
Window), a dialog appears to prompt for the name of the file. If the model has been saved at 
least once, and thus a file name has been assigned to it, MetaEdit saves the model to the file 
shown in the title bar of the Main Window.

The dialog asks for the appropriate path and file name as well as a default extension. In the 
case of Structured Systems Analysis this extension is ".SSA". Enter a file name (which must 
be no more than eight characters long) and select OK. We recommend that you create special 
directories for your MetaEdit models. This will help you to handle and organise them.

The File menu also includes the Save As function which allows you to save a model to a file 
with another name.

Opening existing models

To open models previously saved with MetaEdit, select  File | Open Model. This operation 
opens a dialog for selecting the model files which contain the pictures.

The Open Model dialog has a default file extension "SSA" to select all the models in the 
current directory that are based on Structured Systems Analysis. The file extension can be 
replaced with any other extension to see models based on other methods or by "*.*" so that all 
the files in the directory are shown.

To open the model file containing the appropriate pictures enter the file name, choose from 
the file list and click the  OK button, or double click the file name in the list. As a result 
MetaEdit loads the model file and lists all the pictures included in the file in the picture list of  
the Main Window.

Deleting and renaming pictures

Picture deletion and rename functions are available from MetaEdit's Main Window. To delete 
or rename a picture, first select it from the picture list. As a result the row containing the  
picture name will be highlighted. To delete a picture click the Delete push button. A dialog 
appears to ensure that you really want to delete the picture. If you now select OK, the picture 
disappears from the picture list.



To rename a picture, select the file as in the case of deletion and click the Rename button. A 
dialog appears asking for a new name for the picture. Enter the new name and select OK to 
rename, or select Cancel  if you do not want to change the name after all.  As a result of 
renaming, a new picture name replaces the old one in the picture list.  

Printing

To print pictures you can either select the picture from the Main Window's picture list and 
click the Print push button or print the picture from the Draw Window menu Picture | Print.

However, if you want to change the size of the printout you should go through the Draw 
Window where you can scale the size of the pictures. To select the appropriate size, you can 
scale the picture between 25 and 200 percent of its original size. The size of the paper as 
chosen in Windows printer setup can be seen as a dotted line in the drawing area.

To  optimise  the  printing  scale  you  can  simply  choose  Zoom  |  Fit  To  Page which 
automatically scales the picture to optimally fit on the current page size. After scaling select  
the normal printing function Picture | Print to actually send the picture to your printer.

N.B. The current version of MetaEdit does not allow printing larger pictures than fit on 
one page.

Transferring pictures to other programs

MetaEdit allows you to transfer pictures to other programs through Windows Clipboard. The 
picture formats supported are Windows Metafile and bitmap. In order to transfer the pictures 
select Picture | Copy To Clipboard (CTRL-C) in the Draw Window.  Then go to the other 
program (such as Paintbrush) and paste the copied picture there. 

Reporting

Like all CASE tools, MetaEdit offers reporting functions to check, review or document the 
design results. In MetaEdit the reports come in three different types: 

- Standard reports, which can be used independently of the method used

-  Method  dependent  reports,  which  are  designed  especially  to  complement  the  selected 
method

- User-defined reports, which are fully customised by the users. These can only be created by 
the Method Workbench together with MetaEdit Professional, or purchased from MetaCase 
Consulting.

All the reports available are selected from the Reports menu. The menu displays each report 



type available as a row of the pulldown menu. In the following, we shall briefly discuss each 
of the report types.

Standard reports

MetaEdit comes with a set of standard reports which can be used to study the design results 
independently of the method in use. These standard reports are:

- ObjectList to describe all the objects included in the pictures

- PropertyList to describe all the properties of the objects

- RepositoryContents to describe all the contents of the loaded model file

Method dependent reports

Each method has some characteristics that make it different from others. MetaEdit does not 
take a stand on which method is the best in each situation. Instead it supports every method 
available to it by custom reports. The method dependent reports are especially designed to 
support the method in use. For example, in object-oriented methods reports to check the class 
hierarchy are very useful, but they would not make much sense for data flow diagrams or ER 
diagrams.

The method dependent reports are loaded at the same time that a method is selected or a 
model is loaded. Please see the method manuals (delivered with registered Standard version 
only)  for  more  detailed  information  on the  reports  available  with  the  methods  you have 
chosen to use in MetaEdit.

4. Reference: the functions of MetaEdit
In this chapter, the windows, menus and other functions of MetaEdit are briefly described in a  
hierarchical order.

Main Window

The Main Window has three menus, five push buttons, a list of loaded pictures, and a small  
help bar with brief explanations of the various functions. Double clicking on a picture in the 
list will invoke the Draw Window for that picture.

The File menu

This menu has six menu items which are briefly described below.



New Model brings  up  a  method  selection  dialog,  where  you  can  choose  which  method 
definition (which .mof file) you want to use. You can then start creating a model using the 
chosen method.

Open Model lets you choose which already existing model you want to work with. 
Save Model writes the current model back to the disk.
Save Model As does the same but lets you change the name of the model.
Upgrade Method Definition (only available in Professional versions) lets you upgrade  the 

method of an existing model.
Exit MetaEdit quits the session and returns you to Windows.

The Reports menu

This menu shows you the reports that are defined for the method you are using. Its contents  
depend on the method. For the report you choose, necessary parameters will be asked for and 
the report will be written to the Report Output Window for further processing. The actual 
contents of this menu depend on the method in use. First come the three standard reports 
described in section 3.10.1 above. Then the method specific reports are listed. Selecting any 
of these causes the report parameters to be asked and the report processed. These menuitems 
appear only when a method has been selected.

Design new report (only available with Method Workbench) lets you define custom reports. 
See the separate manual on how to do this.

The Help menu

This menu allows you to see some current statistics about the program and system.

About  MetaEdit  shows  the  MetaEdit  logo,  MetaEdit  version  and  some  statistics  about 
memory usage.

The Push buttons

The push buttons are used to manipulate the pictures of a model.

New opens a Draw Window for creating a new picture.
Edit opens a picture selected from the list, like double clicking a list item.
Rename allows you to change the name of the picture.
Delete removes the selected picture.
Print sends the selected picture to your default printer.

Draw Window



Here we briefly describe the various functions of the Draw Window in the order they appear  
in the menus.

The Picture menu

This menu allows you to print a picture or transfer it through Windows clipboard to other 
programs. 

Print  sends the picture in the Draw Window to your default printer sized according to the 
definitions selelected from the Zoom menu.

Copy To Clipboard copies the picture in the Draw Window to the clipboard from where it 
can be pasted to other programs.

The Edit menu

All the functions collected in the Edit menu expects that one of the object or relationship is  
selected. The effects of a selection can be seen as highlighted menuitems in the menu.

Show Properties  shows the properties  of  a  selected object  or  relationship in a  property 
dialog. 

Explode To Picture  decomposes the selected object into a new picture for further modeling.
Straighten Line  changes the selected relationship from curved line to a straight one.
Delete  removes the selected object with its relationships or the selected relationship from the 

picture.

The Model menu

The Model menu includes all the functions needed for adding objects and relationships into 
the picture. The contents of this menu depend of the selected method and thus always differ 
from method to method.

Change Mode  changes the mode of the Draw Window from object drawing to relationship 
drawing and vice versa. Corresponding function can be found by pushing the right mouse 
button.

A collection of objects depending on the selected method in a alphabetical order. For example, 
in the case of data flow diagrams those objects are External, Process and Store.

Relationships  menuitem  is  a  hierarchial  menu  for  selecting  the  mode  for  choosing 
relationship types. The mode can be either automatic or manual. In the first case the tool 
can select the approriate relationship using its "knowledge" of the method. The manual 
mode of relationship selection contains a list of all possible relationships in the method 
and allows you to select one of them at a time.



The View menu

The View menu includes two menuitems for selecting those objects and relationships which 
you are interested in examining in the Draw Window.

All shows all the objects and relationships drawn in the Draw Window.
Selected  opens a dialog for selecting those objects and relationships which you interested in 

to be shown in the Draw Window.

The Zoom menu

The Zoom menu contains the facilities for scaling the picture presented in the Draw Window. 
The  menu  includes  seven  different  percentages  for  scaling  as  well  as  two  options  for 
optimising the scaling factor to fit the size of the current Draw Window or the selected paper 
size and orientation. 
Scaling factors are show as seven different percentages from 25 to 200. 

Fit To Window  optimises the size of the picture to fit the selected size of Draw Window.
Fit To Page  optimises the size of the picture to fit with the selected orientation and size of 

the paper.

The Refresh! function

The Refresh function redraws the picture in the Draw Window.

Report Output Window

The Report Output Window is an editor for viewing and editing the reports produced from the 
pictures. Here we briefly describe the functions of the Report Output Window in the order 
they appear in the menus.

The File menu

This menu has four menu items which are briefly described below.

Insert File  lets you select and insert an existing file into the Window.
Save writes the current report output to a file.
Save As does the same but lets you change the name of the file.
Print allows you to print the report on the selected printer.

The Edit menu



This menu has five menuitems allowing you to edit the text of the report or transfer it to other  
programs. Below we briefly describe these functions.

Cut  removes the selected part of the text to the clipboard.
Copy  function makes a duplicate of the text to the clipboard.
Paste  attach the text from the clipboard to the text in The Report Output Window.
Clear  deletes the selected text block.
Select All  selects all the text in the Report Output Window to be either removed or copied to  

other programs.

The Search menu

This menu contains three menuitems allowing you to either find or replace parts of the text.

Find allows you to search for any string.
Find Next places the cursor to the next place where the string selected with the Find function 
is found.
Replace allows you to replace part of the text with other text.
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